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Introduction 
 

A test package set (TPS) containing a range of questions and activities from each of the four assessment task areas has been provided. This can be used to familiarise 
pupils with software used in the key stage 3 (KS3) information and communication technology (ICT) assessment tasks and the task environment (the ‘toolkit’). For support 
with running the familiarisation materials refer to the training guides available from the support materials section at www.naa.org.uk/ks3ict.  
 
The TPS consists of three questions and six activities including a variety of supporting assets. The TPS can be used for familiarisation in one of two ways:  
 

 the questions and activities provided can be used directly with pupils  

 teachers can set their own questions or activities for pupils using the assets that are provided in the TPS. 

 

Note the familiarisation TPS does not produce a pupil or group report. 
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Familiarisation questions and activities 
 
When pupils log on to the familiarisation TPS they receive an email. This asks pupils to use the link provided to see the questions and activities provided. The link takes 
pupils to an Introduction page in the web browser, which lists all the questions and activities available in the TPS. Pupils use the buttons on the left-hand side of the page 
to access these. 
 
To help teachers to become familiar with the content of the TPS the following table describes each of the questions and activities provided. 
 
Table 1: Familiarisation questions and activities 
 

Curriculum area Description 

Question 1 
Pupils are asked to select the appropriateness of data handling applications for a list of situations. 

Activity 1 
Pupils are asked to create a graph from a simple database containing data from a class survey about 
the number of pets and the number of brothers and sisters pupils have. Pupils are then asked to add 
their graph to a report and to save their work in a specified folder. 

Data handling 

Activity 2 
Pupils are asked to use a more complex database from a school survey about the number of pets and 
the numbers of brothers and sisters to answer a series of questions. In order to answer the questions 
pupils need to sort, query or filter the data. 

Question 2 
Pupils are asked to decide which statements about spreadsheets are true and which are false. 

Modelling 

Activity 3 
Pupils are asked to add a title and formula to a spreadsheet containing costs for a band. 
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Curriculum area Description 

Activity 4 
Pupils are asked to complete a presentation about Pepford. Pupils then have to email the presentation to 
Simon Jones at Pepford Tourist Information Centre. This activity will familiarise pupils with transferring 
text and images from a website to a presentation and with changing the formatting within the 
presentation. 

Presenting and handling information 

Activity 5 
Pupils are asked to add an image to a report about community policing in Pepford. To do this pupils need 
to complete a simple web search to find a suitable image, add the image to the report and then email the 
report to Li Lui at Pepford Police copied to John Hughes. 

Question 3 
Pupils are asked to choose the appropriate instructions needed to draw some shapes. 

Control 

Activity 6 
Pupils are asked to change a control system for a car park barrier so that the system behaves as 
required. 
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Setting your own tasks 
 
You may feel that your pupils are not familiar with certain aspects of the ICT toolkit and you may wish to set different tasks for your pupils in addition to those provided. 
Below are some examples of the types of other activities that you may wish to carry out with your pupils. 
 
Types of activities 

 
Lesson starters – you may want to use these materials to target a specific aspect of ICT as a lesson starter. For example, you could cover how to search a database. 
 
Whole-class teaching – you may want to use these materials to introduce pupils to the toolkit and teach specific aspects of ICT before the pupils use the pupil 
familiarisation materials for themselves. An interactive whiteboard would be useful for this demonstration. 
 
Ideas for activities using the applications 

 
Email – your pupils may be unfamiliar with using email. At the beginning of all the KS3 ICT assessment tasks pupils receive an email which contains a link to the questions 
and activities so pupils must be able to open emails. Some tasks ask pupils to send emails with attachments. You could create a lesson around opening emails, sending 
emails, sending emails with attachments and using contacts. 
 
Database – your pupils may need help with using the database effectively. You could devise a lesson around using sorts, filters, queries and charts in the database. The 
importance of data types and validation in databases could also be covered. 
 
Modelling – your pupils may need practice at creating and using a spreadsheet model. You could devise a lesson around getting the pupils to create a simple model in the 
spreadsheet and to use this model to answer some questions.  Validation and the use of functions in spreadsheets could also be covered. 
 
Control – your pupils may need to become familiar with the control application. You could create a lesson that includes a brief demonstration of the application (an 
interactive whiteboard would be very useful here) and a range of tasks for pupil to complete, which will involve them in increasingly sophisticated development of the given 
system. They can be introduced to the basic flowchart elements (how they are added, joined and edited etc).  The simulation (inputs, outputs, how it is controlled), and more 
sophisticated ideas such as sub-routines and counters. 
 
In addition, you may want to set some simple tasks within each of the applications. Pupils could complete these individually or in pairs and identify ways in which ICT toolkit 
applications are similar to, or different from, other applications with which pupils are more familiar.  When taking feedback from pupils, it would be helpful to get them to 
reflect on how they addressed any differences. If pupils identify the strategies they have employed in these cases, it is more likely they will be able to apply these to other 
similar situations when working with different software. 
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Assets in the familiarisation test package set 
 

To help you to use the materials for your own tasks copies of the assets used in 
the activities have been provided in the Sample Files folder.  Providing copy files 
ensures the set activities will always be available and accurate regardless of any 
changes made to the copy file. 
 
• Band Costs (copy) – simple spreadsheet model 
• Car Park Barrier (copy) – control flowchart 
• Class Survey Report (copy) – word processer file 
• Class Survey (copy) – simple database file 
• Community Policing Report (copy) – word processer file 
• Pepford Presentation (copy) – simple presentation 
• School Survey Results (copy) – word processor file 
• School Survey (copy) – extended database file. 
 

The email application contains the following contacts: 
 

 

The virtual internet contains the following websites: 

• Pepford Council website 
• Pepford Tourist Information Centre website 
• Pepford Leisure Centre website 
• Pepford Police website. 

 
 

ICT toolkit application menu options 
 

The following pages show the menu options for the applications in the ICT toolkit. They show some of the functionality that may operate differently to the software pupils 
normally use. These pages could be printed off and given to pupils to aid their preparation.  

First name Surname Email address Address 

Sam Barton head@pepcs.walton.sch.uk Pepford Community School, Pepford, Waltonshire, WX2 3DJ 

Simon Jones sjones@tic.org.uk Tourist Information Centre, Mane Road, Pepford, Waltonshire, PF1 1MR 

Li Lui llui@police.gov.uk Police Station, East Way, Pepford, Waltonshire, PF1 1EW 

John  Hughes jhughes@police.gov.uk Police Station, East Way, Pepford, Waltonshire, PF1 1EW 
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Minimise, maximise  

restore and split screen 

You can minimise, maximise and split 
the screen. 
 

Click this button to 
minimise the file. 
 
 
Click this button to 
maximise the file. 
 
 
Click this button to 
restore the file. 
 
 
Click this button to use 
Split screen. 

 

 

Task Information window 
The Task Information window has 
three main buttons – Help, Task 
Information and Objectives. 
 
 
Click the Help button to search for help 
about the applications. 
 
 
Click the Task Information button to 
see the last test information. 
 
 
Click the Objectives button to see the 
objectives for the task that you are 
taking. 

 
Changing between files 
You can change between files using the Show all open windows button or the 
application toolbar. 
 
    Click this button to Show all open windows. 
 
 
 

Click an application to see all of the open files for 
that application.  Follow the arrow to select the file.  
The small button moves to the left to indicate open 
files. 

 

 

Some window areas, such as the application 
toolbar, can be hidden.  The bar at the edge of 
the area will have an arrow on it. 
 
Click on the bar to hide an area.   
Click on the bar again to show the area. 

Hide/show window areas 

Task environment 
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File menu 

You can use 
this menu to 
create a 
New 
Message 
and manage 
your emails. 

 
Email tip When a new email arrives, this is 

shown at the top left of the Task 
Information window.  
 
Click the check email button to go 
to your Inbox to see your email. 

 
Edit menu 

 

Use this menu 
to Copy and 
Paste text.  
 
For example, 
you could copy 
an email 
address and 
paste it into the 
To box.  

 
Contacts menu 

Use this menu to 
manage email 
Contacts.  
 
You can create 
contact Groups 
and also find and 
sort your 
contacts.  

 

Messages 
menu

 

Use this menu to 
Reply to 
messages, Add 
Attachments and 
Send messages.
 

 

You can Spell Check or 
Grammar Check your 
messages. 

Tools menu 

 

 

Email 
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File menu 

Use this menu to Open, Delete, Move 
and Rename files.   

 
View menu 

Icon View shows an icon for 
each file and the filename below 
the icon. 
 
Details View shows a list of the 
files.

 
Folder menu 

Use this menu to create New Folders and 
manage existing ones.  

Edit menu 

Use this menu to Copy 
and Paste files.  

Browsing for files 

Click on the + or double click on My Computer to 
expand the folder tree and browse for folders and 
files. 

File manager  
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File menu 

 
Use this menu to Save your file and to 
Print Preview your document.   
 
You can also use it to Send the file as an 
email attachment. 

 
Edit menu 

Undo will only undo 
your last change. 
 
Use this menu to 
Copy and Paste 
text or Paste Link 
items from other 
files.  

 
Insert menu 

Use this menu to insert Clip Art, 
Images, Word Art or Tables.  
 
Page Number, Date and Filename are 
available when Master Page is used. 
 
Field is used to insert a field for a mail 
merge.  You need to link the document 
to a spreadsheet data source using the 
Mail Merge option in the Tools menu. 
 
You can insert a Hyperlink into a word 
processor document. 

 
Tools menu 

You can 
Spell Check 
or Grammar 
Check your 
document.   
 
You can use 
Mail Merge 
to attach a 
spreadsheet 
data source 
to the 
document. 

Format menu  
Edit Master Page 
allows you to 
change the 
background for 
the whole 
document and 
apply headers 
and footers.  You 
can also edit text 
styles.  
 
With Switch to 
DTP Mode you 
use Text Frames 
for all text in the 
document. 

 

    Word processor (1) 
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Master Page menu 

This menu option only appears 
when you select Edit Master 
Page from the Format menu. 
 
You can add a Background 
Image to all the pages in your 
document. 
 
Use Global Image if you want to 
place an image in a specific 
position in each document.  For 
example, you may want to add a 
logo to the top of each page. 
 
Use Edit Properties to change 
the background colour of pages. 
 
Use Edit Style to add and edit 
your own text styles. 
 
You must Close Master Page 
before you can continue editing 
your document. 

   Image menu 

You need to select 
an image before 
this menu is shown.
 
Use this menu to 
change the way an 
image is shown in 
your document.  
 
 

 
 Table menu 

You need to 
select a table 
before this menu 
is shown. 
 
Use this menu to 
make changes to 
a table in your 
document.  
 
 

Anchor to Character fixes the position of the image to a text character.  You can only 
place the image next to some text.  The first line of text is placed beside the image. 
 
Anchor to Page Location makes the image float and allows it to be positioned 
anywhere on the page, for example on top of text.   

Object anchoring 

 

   Word processor (2) 
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Chart menu 

This menu only 
appears when a chart 
is selected. 
 
You can change the 
way your chart looks 
using Options. 

 
File menu 

 

Use this 
menu to 
Save your 
file and to 
Print 
Preview 
your 
document.  
 
You can 
also use it 
to Send 
the file as 
an email 
attachment

 
Edit menu 

Undo will only undo the last 
change. 
 
Use this menu to Copy and 
Paste items.  You can also 
Paste Link items from 
another worksheet or another 
file, so that it updates 
automatically.  
 
You can use Fill Down and 
Fill Right to copy your 
formula down or across into 
several cells. 

 
Data menu 

You can Filter and 
Sort data in your 
spreadsheet. 
 
You can add 
Validation to cells. 

 
Tools menu 

 

You can 
use Goal 
Seek to 
achieve a 
specific 
target 
number by 
changing 
the value 
in another 
cell.  

Insert menu 

You can 
create a 
Chart, insert 
a Function 
(for use in a 
formula) into 
a cell or 
Name a cell 
range. 

Format menu 

You can add Conditional 
Formatting to cells.  The 
value of the cell will 
change how it looks. 

Spreadsheet 
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File menu 

Use Save Image to save an image 
from a web page. 
 
You can Send the URL of a web 
page as a link in an email. 

 
Favourites menu 

You can add a web page to My 
Favourites using Add A Favourite. 
 
You can create a folder to organise your 
favourites using Add A Favourites 
Folder. 

 
Edit menu 

Use Copy Image to copy an image 
from a web page.   
 
Use Find to look for text on the 
current web page 

 
Pepsearch tabs 

Use the Web tab to search for web 
pages using search keywords. 
 
Use the Image tab to search for media 
items such as images using search 
keywords. 
 
Use the Advanced tab for more 
complex searches. 

View menu 

Go To Home Page will 
return you to the home 
page; the default home 
page is the Pepsearch 
search engine. 
 
History shows a list of 
the websites you have 
visited. 

 

Web browser 
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Creating a chart 

 

Select the field that you want on 
the chart and click the View 
Chart tab to see your chart. 

 
Buttons and tabs 

Use the buttons below the main 
toolbar to work with a Table, Query or 
Chart. 
 
Use the tabs below these buttons to 
switch between design/edit mode and 
view/run mode.  

 

You can use Save As to save your 
database as a CSV file. A CSV file can be 
opened by the spreadsheet application. 
 
You can use Import CSV to open a CSV 
in the database.

File menu 

 
Database menu 

 

Use this menu to create New 
Queries or New Charts.  
 
You can also use the tabs to 
switch between the Edit Fields 
View and Table Datasheet 
View.  

 
Edit menu 

Undo
will only 
undo the 
last 
change. 

 
Data menu 

You can use this menu to 
Sort or Filter on a table or 
a query. 

 

Database (1) 
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Creating a query 

 

Click the Query button to create a new 
Query.  You can base a query on the 
Table itself, or on a Query you have 
already created. 
 
You can hide the application sidebar to 
avoid scrolling. 
 
Use the Edit Query view to define your 
new query.  You can enter the query 
conditions and also decide which fields 
you want to show and sort. 
  
Click the Run Query tab to run the query. 

 
Choose fields 
In the Edit Query view use the drop 
downs to select the fields to be used in 
the query.  
You can also choose to Sort the data, 
and whether to show the field when 
you run the query. 

 
Database menu The Database Menu options 

change when you are working 
with queries. 
 
You can switch between the Edit 
Query and Run Query views. 
 
You can use Save Query As to 
create a copy of the query with a 
different name.  

Choose conditions and 
values 
In the Edit Query view, use the drop 
downs to select u p to six fields and the 
conditions  and values (record selection 
criteria) you want to use.  

You link each criterion to the next by 
selecting the And or Or logic.  
Brackets indicate the grouping or 
precedence of the criteria. 
 
You can change the precedence using 
the arrows either side of the And or Or 
logic drop-downs. 
 
Below your selections, you will see the 
logic Expression from your conditions 
and values, also with brackets to show 
precedence. 

  

Database (2) 
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File menu 

 
You can use Loop Slide Show to repeat 
a presentation. You can also Send the 
file as an email attachment 

 
Tools menu 

You can use 
Spell Check to 
check your 
presentation.  

 
Slides menu 

You can use 
Slide Transition 
to change the 
way slides 
advance. 

 View menu 

 
Use this menu to switch between 
Normal view and the Slide Sorter view. 
 
You can see your slide show using View 
Slide Show.  Press Esc on the 
keyboard to exit View Slide Show. 
Press Enter or click the mouse to move 
to the next slide. 

 
Edit menu 

Undo will only 
undo the last 
change. 
 
Paste Link will 
paste a table or 
chart into the 
document that 
will automatically 
update when the 
original 
document is 
changed.  

View menu 
Use this menu to 
switch between 
Normal view and the 
Slide Sorter view. 
 
You can see your slide 
show using View Slide 
Show.  Press Esc on 
the keyboard to exit 
View Slide Show. 
Press Enter or click 
the mouse to move to 
the next slide. 

Insert menu 
You can add a 
Text Box to a 
slide.  
 
You can add a 
Hyperlink to a 
file or web site. 
 
An Action 
Button can link to 
a file, web site or 
a slide. 

  

Presentation 
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Control 
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Opening files 
The Control applet can only open with a 
control file.  

 
Simulation area 
Use this to watch how 
the system responds to 
your flowchart and set 
inputs.  Click Display 
Simulation Key  in the 
simulation menu for 
more details of the 
system. 

 

 
Controls 
area 
Click on a symbol in the flowchart area.  You 
can now choose exactly what an element 
does.  You must click the Apply button 
when finished. 

 
Insert menu 
Make more space in the 
working area by adding 
rows or columns 

 
View menu 

Use this to look at the 
whole chart (Zoom Out), 
or just a part of it (Zoom 
In). 

Flowchart area
Here you 
create your 
flowchart 
by 
dragging in 
elements 
from the 
toolbar. 

Simulation menu 

Use this menu to start, stop and 
step the system, and see how the 
simulation works. 

Flowchart menu

Add new 
flowchart 
elements 
from this 
menu or 
from the 
tool bar.

 
Subroutine menu  

Use this menu 
to create other 
flowcharts that 
can be used in 
the main 
flowchart. 
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About this publication 

Who is it for? 
People preparing pupils to use the KS3 ICT assessment tasks, for example: ICT subject 
leaders, ICT teachers, ICT coordinators. 

What is it for? 
Familiarisation materials provide information and guidance on how to familiarise pupils 
with the functionality available within the task software. 

What does it cover? 
 overview of the questions and activities provided in the familiarisation test package 

set 
 support for setting your own tasks within the toolkit 
 common menu options in the toolkit applications. 

Related materials 
KS3 ICT assessment tasks 
General support materials 
Task support materials 
Training guides  
Progression grid 
Progression grid companion 
Non-toolkit version of the tasks 
The above are all available from www.naa.org.uk/ks3ict 

Information and contacts 
If you have any general queries about the support materials for the KS3 ICT assessment 
tasks, please contact the KS3 ICT team. 
Email: ks3ict@naa.org.uk 
Website: www.naa.org.uk/ks3ict 
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